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FAQs 
 

What is the goal of the monthly CAS to MTP import? 

In 2021, the goal is to have the Training Center and Locals download and import their Local-specific CAS 
files from the LIUNA Chicago CAS Portal each month into MTP on a timely basis to increase the accuracy 
and integrity of membership data. 

 

What is the District Council’s Contribution Accounting System (CAS)? 

CAS is the accounting system used by the LIUNA Chicago Laborers’ District Council to track and manage 
contractors and members. Contractor and Membership reports and Local-specific CAS data files (to be 
imported into MTP), are created on a monthly basis for each respective Local to access and download 
from the District Council CAS Portal. 

 

What is the LIUNA Chicago CAS Portal? 

The LIUNA Chicago CAS Portal https://portal.cvldc.org is a secure and encrypted website where Locals 
can view contractor and membership reports and download Local monthly CAS Zip files. This portal 
leverages District Council accounting data that is tracked and managed by District Council’s Contribution 
Accounting System (CAS). 

 

Who has access to the CAS Portal? 

The person responsible for membership and membership accounts at each Local, such as the Secretary-
Treasurer and/or Office Manager, should have access and be trained on how to leverage the reports and 
data provided by CAS Portal https://portal.cvldc.org. In all cases, the Business Manager determines who 
will have access to the CAS Portal by submitting names to the District Council. Please contact Kate 
Hughes at khughes@liunachicago.org for more information or questions. 

 

  

https://portal.cvldc.org/
https://portal.cvldc.org/
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How to download the iPhone and Android CAS Portal app on your mobile phone? 

Since the CAS Portal app cannot be found in the Apple App Store (iPhone) or Google Play App Store 
(Android), use the following links to learn how to prepare your phone so you are able to download and 
install the CAS Portal app on your mobile phone. 

iPhone: 

1. Please delete any existing CAS Portal app from your iOS device 
2. Open the Safari browser on your phone 
3. Enter https://portal.cvldc.org:1050 and then select GO button 

Android: 

1. Read this article first to prepare your Android phone before installing the CAS Portal app 
2. Then download the APK file for the Android app here: 

https://portal.cvldc.org/casldcandroid.html  

 

What are the benefits of completing your monthly CAS to MTP import? 

1. Ease data entry procedures and increase accuracy of membership data when data already exists 
in another system – e.g. Contribution Accounting System (CAS) 

2. Improve integrity of membership data between the District Council, Training Center, and 
affiliated Locals 

3. Resolve discrepancies between the Local and District Council with local assignments, standard 
membership types, and verify accuracy of work hours for MCL benefits 

4. Stay up to date monthly regarding: 
o TRAVELERS (without data entry) can be tracked automatically in your Local MTP with a 

standard membership type and contact information 
o New and updated contractor profiles from CAS  
o Monthly accounting records of membership work hours 

 Found under the Contractor Hours tab on the Member side of MTP  
 Found under the Batch Payments tab on the Contractor side of MTP 

5. Provide your membership with secure access to view an updated list of their work hours, across 
any Local, via the Membership Portal 

 

When should you complete your monthly CAS to MTP import? 

Ideally, you should complete your monthly CAS to MTP import before the end of the month to ensure 
reconciliation of discrepancies with District Council before the next month’s close of business – that date 
is typically on the third Thursday of every month. 

 

https://portal.cvldc.org:1050/
https://www.lifewire.com/install-apk-on-android-4177185
https://portal.cvldc.org/casldcandroid.html
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Where will you download your Local-specific CAS data file for the CAS to MTP import? 

On a regular monthly schedule, your Local-specific CAS data file will be available to download from the 
CAS Portal https://portal.cvldc.org, typically, on the third Thursday of every month. 

 

How do you review your imported CAS data after you complete your monthly import? 

The Local-specific CAS data file tracks your membership from the signed “Dues Checkoff Authorization 
and Wage Assignment” (Dues Checkoff) form through the collection of contractor hours and work dues. 
It also automatically keeps your Local up to date on all of your contractor data such as contact 
information and affiliation code. 

During the CAS to MTP import process, multiple PDF reports will be created. This step-by-step guide will 
direct you to save each PDF reports accordingly before you exit the Print Preview. You will review and 
print these PDF reports to reconcile any discrepancies.  

Once the CAS to MTP import is complete, the imported data can be viewed in MTP, at any time, under 
two locations:  

1) Contractor Hours tab on the Member side of MTP 
2) Batch Payments tab on the Contractor side of MTP 

 

Would you like help with your monthly CAS to MTP import? 

If you’d like to learn or you need help with importing your local-specific CAS file into MTP, please 
contact INCOM MTP Support or send an email to Matt Oster at moster@netincom.com. 

  

https://portal.cvldc.org/
https://www.membershiptrackingprogram.com/support
https://www.membershiptrackingprogram.com/support
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Checklist  
 

• Check and verify your Local login and password for the CAS Portal https://portal.cvldc.org. 
o If you don’t know this information, please contact District Council. 

 
• Know your two Zip passwords to extract your Local-specific CAS Zip files to your computer. One 

password is for Local 0000 and another password is for your Local ####. 
o Note: This password is not the same as the CAS Portal password. If you don’t know this 

password, please contact District Council. 
 

• Check that you have the extract software “7-Zip” installed on your computer. 
o This step is documented in the PC and MTP Setup. 

 
• Check that MTP is up to date by going to MTP Desktop > Utilities > Check for Updates. 

o This step is documented in the PC and MTP Setup. 
 

• Check that the option “Prohibit payments to archived individuals” is unchecked by going to the MTP 
Desktop > System Settings > Payments. 

o This step is documented in the PC and MTP Setup. 
 

• Check and verify that you are logged in as your WORKDUES cashier in MTP 
o This step is documented in the PC and MTP Setup. 

  

https://portal.cvldc.org/
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PC and MTP Setup 
 

1) Set up your CAS Import folder structure 
 
Before you perform your CAS to MTP Import, please take 
the time and set up a Year > Month CAS Work Dues folder 
structure in your “Documents” or “Shared” drive location. 
Ideally, this folder structure should be on a shared drive so 
you have the confidence that it’s backed up and accessible 
by others in your office. (Image 1a) 
 
Why are you doing this? 
 
To be organized with your monthly Local-specific CAS 
Import data and PDF reports. 
 
Each month, you will have at least 16 to 18 PDF reports that 
should be saved, reviewed, managed, and printed as 
needed. 
 
 

FYI: You’ll have to create a new folder for each month. 
 
Year > Month Folder Example: 

• “Documents” or “Shared Drive” location 
• CAS Work Dues (folder) 

 2021 (folder) 
• 01 Jan (folder) 
• 02 Feb (folder) 
• 03 Mar (folder) 
• Etc. 

 

 
Image 1a 

 
 

Note: Your Local-specific CAS Zip files are for the close of 
business for the prior month. Hence, when you download 
February Zip files, the data inside is for January. 

 
 
2) Install the extract software “7-Zip” on your 

computer 
 
Before you perform your CAS to MTP Import, visit 
https://www.7-zip.org and select the appropriate 
Download link with respect to your Windows version – 32-
bit or 64-bit (Image 2a). 
 
To determine what version of Windows you have installed – 
32-bit or 64-bit:  
 
What are the steps? 
 
A) Open a File Explorer window (Windows Key + E) 
 
B) On the left, right-click This PC 
 
C) In the context menu, select Properties (Image 2b) 
 
D) Look for System type (Image 2c) 
 

FYI: You’ll only have to do this once. 
 

 
Image 2a 

 

https://www.7-zip.org/
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Why are you doing this? 
 
This extract program is used to securely “unzip” your Local-
specific CAS Zip files with a password after you download 
them so you can have access to the monthly PDF reports 
and the single Local-specific CSV file from CAS.  

 
Image 2b 

 

 
Image 2c 

 
 

3) Check and verify that Payments option “Prohibit 
payments to archived individuals” is unchecked 
in MTP 

 
Before you perform your CAS to MTP Import, please go to 
the MTP pop-down menu and select  
File > Open > Lookup Tables > System Settings. 
 
You can always use the Search menus box, in the upper 
right-hand corner of MTP, and type system. Then select, File 
> Open > Lookup Tables > System Settings…  
(Image 3a). 
 
What are the steps? 
 
A) At the bottom left, in the System Settings Filter search 
box, type import (Image 3b). 
 
B) Verify that your MTP has the Payments option,  
Prohibit payments to archived individuals is not checked  
(Image 3b). 
 
 
 
 
 

FYI: You’ll only need to do this once. 
 

 
Image 3a 

 

 
Image 3b 



 
 
 
 

5/22/2024  8 
 

Why are you doing this? 
 
Because contractors can be audited for prior years, you 
want to make sure that work dues will be distributed to a 
member that is archived in MTP. 
 

 
4) Create a WORKDUES cashier in MTP 
 
Before you perform your CAS to MTP Import, please create 
a “working dues” MTP Cashier. If you already have a 
WORKDUES cashier, proceed to Step 9. 
 
What are the steps? 
 
A1) Go to the MTP pop-down menu and select  
File > Open > Lookup Tables > Users/Cashiers… 
 
A2) You can always use the Search menus box, in the upper 
right-hand corner of MTP, and type cashiers. Then select, 
File > Open > Lookup Tables > Users/Cashiers… (Image 4a). 
 
B) Once the Cashiers table is open, click Add New… 
(Image 4b). 
 
C) In the Cashier window, under the General tab, type the 
Username WORKDUES and the Fullname WORKING DUES 
(Image 4c). 
 
D) Provide your own Password and Confirm Password it for 
the WORKDUES cashier (Image 4c). 
 
E) Then select the Roles tab, check Administrator, and 
unselect Agent, Training Coordinator, and Web Module 
User (Image 4d). 
 
F) Click OK. 
 
G) In the Cashiers table, click Close (Image 4c). 
 
Why are you doing this? 
 
As a best practice, DO NOT USE your daily MTP cashier 
(where you take membership payments) for the CAS to MTP 
Import process. 
 
ONLY USE the WORKDUES cashier for the CAS to MTP 
Import process – importing/posting batch payments. If 
anything happens during the import process that requires 
INCOM Support, you can leave the WORKDUES cashier open 
until the import errors/failures are corrected.  

FYI: You’ll only need to do this once. 
 

 
Image 4a 

 

 
Image 4b 

 

 
Image 4c 

 

https://www.membershiptrackingprogram.com/support
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Image 4d 

 
 

5) Run the Pad Contractor Numbers Tool to check if 
your Contractors all have unique six-digit 
Contractor Numbers in MTP 

 
Before you perform your CAS to MTP Import – please run 
the Pad Contractor Numbers Tool.  
 
The Pad Contractor Numbers Tool checks the following to 
identify: 
 
• Contractors that have a base contractor number but 

have less than six digits, i.e. missing leading zeros 
• Duplicate contractors with the same base number 

 
Examples (Image 5a): 
 

Pepper Construction – 003514 
Pepper Construction – 03514 
 
What are the steps? 
 
A1) Go to the MTP pop-down menu and select  
Utilities > Pad Contractor Numbers Tool. 
 
A2) You can always use the Search menus box, in the upper 
right-hand corner of MTP, and type pad. Then select,  
Pad Contractor Number Tool (Image 5b). 
 
B) In the Pad Contractor Number Tool window, confirm 6 as 
the “desired width for numeric contractor numbers” and 
click OK (Image 5c). 
 
C) Enter the numerical code to confirm that you want to 
proceed and click OK (Image 5d). 

FYI: You’ll only need to do this once. 
 

 
Image 5a 

 

 
Image 5b 
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D) Click, Yes (Image 5e). 
 
E) Continue to Step 11 if a Print Preview of the report, 
Contractor Numbers that Could Not Be Update Report, is 
automatically displayed full screen. 
 
F) If no report was displayed, all your contractors were 
updated successfully. Proceed to Step 12. 
 
Why are you doing this? 
 
Moving forward, all contractors must have unique six-digit 
CAS contractor numbers, including leading-zeros, in MTP. 
 
The CAS to MTP Import process now reconciles and 
identifies contractors based on CAS contractor number, not 
name. Therefore, each existing contractor in your MTP must 
have a unique six-digit contractor number that is verified 
and can be automatically mapped to a CAS contactor 
number. Basically, we are cleaning up your existing 
contractors in your MTP for accuracy of data and speeding 
the import process. 
 
 

 
Image 5c 

 

 
Image 5d 

 

 
Image 5e 

 
 

6) Fix Contractor Numbers that could not be 
padded/updated in MTP (if required) 

 
Before you perform your CAS to MTP Import – A Print 
Preview of the Contractor Numbers that Could Not Be 
Update Report is automatically displayed full screen 
(Image 6a) 
 
Save as PDF by clicking the Save icon (Image 6b). 
 
Save the PDF to the appropriate folder month under the 
Year > Month folder structure that you created in Step 1. 
 
Print the PDF report. 
 

FYI: You’ll only need to do this once. 
 

 
Image 6a 
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Each contractor in the report has an Exception description 
to explain what prevented MTP from updated the existing 
number to a six-digit CAS contractor number.  
 
Example where two duplicate contractors exist in MTP with 
the same base number, 365 (Image 6c): 
 

BULLEY & ANDREWS – 00365 (must be addressed) 
BULLEY & ANDREWS – 000365 
 
These duplicate contractors must be addressed before 
performing a CAS to MTP Import or the contractor with the 
non-six-digit contractor number (00365) will produce batch 
import record failures in Step 19.  
 
What are the steps? 
 
A) Under Contractors, search for the base contractor 
number (including Archives) using the Contractor Number 
pop-down search option – your search result will find the 
two duplicate contractors with the same base number in 
MTP. 
 
B) Go to Tools > Contractor Merge Tool (Image 6d). 
C) In the Contractor Merge Tool window, click the three-dot 
menu under Contractor(s) to delete (Image 6e). 
 
D) Search for the base contractor number again (including 
Archives) using the Contractor Number pop-down search 
option. 
 
E) Once found, select the other contractor with same base 
number that you want to delete/merge. 
 
F) Check the option, Set as an alias and archive if merge 
fails (Image 6e). 
 
G) If successful, move to the next contractor 
 
H) If first merge was unsuccessful, try a Reverse Merge – 
merge 000365 with 00365 with same steps and option 
previously. 
 
I) If successful the second time, rename 00365 by padding it 
with a leading zero – i.e. 000365 
 
J) If both merge options fail,  

o Rename 00365 to Z-00365 by clicking the three-
dot button (Image 6f) 

o Turn ON the Archived button for the renamed 
contractor 

 
Image 6b 

 

 
Image 6c 

 

 
Image 6d 

 

 
Image 6e 

 



 
 
 
 

5/22/2024  12 
 

In summary… 
 
1) Try Merge (keep good, delete/merge bad contractor) 
2) Then Reverse Merge (keep bad, delete/merge good, 

then rename contractor to the good CAS number) 
3) If both merge options fail, then we have to rename 

(rename to OLD-contractor#), plus archive 
 
As reminder before proceeding to Step 12…  
 
All the contractors listed in the Contractor Numbers that 
Could Not Be Updated Report must be addressed before 
performing a CAS to MTP Import or the listed contractors 
will produce batch import record failures in Step 19. 

 
Image 6f 
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CAS to MTP Import Step-by-Step Guide 
 

1) Create a new month folder for your CAS data 
 
Create a new month folder under your Work Dues folder 
structure in your Documents or Shared Drive location for 
CAS data you’re going to download (Image 1a). 
 
Your Local-specific CAS Zip files (Step 3) are for the close of 
business for the prior month. Hence, you’re download 
February Zip files for CAS data from January. 
 
Why are you doing this? 
 
To be organized with your monthly Local-specific CAS 
Import data and PDF reports. 
 
Each month, you will have at least 16 to 18 PDF reports that 
should be saved, reviewed, managed, and printed as 
needed. 

[Year] [Month] Folder Structure Example: 
 

• Documents or Shared Drive location 
• CAS Work Dues (folder) 

 2021 (folder) 
• 01 Jan  
• 02 Feb 
• 03 Mar 
• 04 Apr NEW 

 

 
Image 1a 

 
 
2) Go to the CAS Portal https://portal.cvldc.org and 

log in with your User name and Password 
 
Log into the CAS Portal (Image 2a). 
 
Why are you doing this? 
 
This is a secure location where District Council saves your 
Local-specific CAS Zip files, which contain your last month’s 
close of business membership work dues. 
 
 

 
Image 2a 

 
Note: If you don’t know your Local’s user name and password, 
please contact District Council’s Kate Hughes at 
khughes@liunachicago.org. 
 
 

 
 

https://portal.cvldc.org/
mailto:khughes@liunachicago.org
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3) Download your five Local-specific CAS Zip files 
from CAS Portal into your Year > Month folder 
structure 

 
Find and download the following Zip files to your Year > 
Month folder structure that you created in Step 1. 
 
What are the steps? 
 
A) In the upper-right hand corner of the Portal page, click on 
Local Union Data (Image 3a). 
 
B) On the left-hand side, under Monthly Reports, click 
OPEN FOLDER. 
 
C) On the left-hand side, click on the triangles to expand 
each section to the correct year (Image 3b). 
 
D) Under Local 0 Monthly Reports, under the [Year] 
structure, then download your two report Zip files: 

1) Detail Contribution by Local 
2) Detail Contribution by Local and Contractor 

 
E) Under Local # Monthly Reports, click the [Year], and then 
download your two report Zip files: 

1) Detail Contribution by Local 
2) Detail Contribution by Local and Contractor 

 
F) Under Local # Monthly Files, click the triangle, click the 
[Year], and then download your one CSV Zip file: 

3) Monthly Data Extract 
 
G) Take note and remember the Publish Date (aka the Close 
of Business date) on the CAS Portal Zip files. You will use this 
date in Step 21 (Image 3c). 
 
Why are you doing this? 
 
These five Local-specific CAS Zip files contain working dues 
PDF reports on Zero-list (Local 0000) and Local #### 
members, and most importantly, a Local-specific CSV file 
from CAS that contains Local work dues data to be imported 
into MTP (Image 4a). 

 
Image 3a 

   
Image 3b 

 

 
Image 3c 
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4) Open and extract all five Local-specific CAS Zip 
files inside your Year > Month folder structure 

 
Open and extract all five Local-specific CAS Zip files 
individually using 7-Zip and the appropriate passwords 
(Image 4a): 
 

• Local0000@cvldc 
• Local####@cvldc 

 
 
What are the steps? 
 
A) Right-click on one of the Zip files. 
 
B) Navigate and select 7-Zip > Extract Here (Image 4b). 
 
C) The Enter Password window will appear (Image 4c). 
 
D) Enter the appropriate Zip password for the appropriate 
CAS Zip file. 
 
Note: Always use the Extract Here option and do not open 
or save your local-specific CSV file with Microsoft Excel. If 
you do, this file will not import into MTP. If that happens, 
please delete it, start over, and extract the Zip file again. 
 
Finally, after extracting all five Local-specific CAS Zip files, 
you will have four PDFs and one CSV file from CAS 
(Image 4d). 
 
Why are you doing this? 
 
After you extract all five Local-specific CAS Zip files, you will 
be able to view/print the PDF reports and most importantly, 
import the CSV file from CAS into MTP. 

 
Image 4a 

 

 
Image 4b 

 
Note: If you don’t know these two Zip passwords, please contact 
District Council’s Kate Hughes at khughes@liunachicago.org. 

 

 
Image 4c 

 
Image 4d 
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5) Check and verify that MTP is up to date 
 
Very important! Verify that your MTP is up to date. 
 
What are the steps? 
 
A1) Go to the MTP pop-down menu and select  
Utilities > Check for Updates (Image 5a). 
 
A2) You can always use the Search menus box, in the upper 
right-hand corner of MTP, and type update. Then select, 
Utilities > Check for Updates (Image 5b). 
 
B) After the program download and once the click OK to 
start the MTP update, all users must be out of MTP  
(Image 5c). 
 
C) Click Yes. 
 
Why are you doing this? 
 
By checking/verifying that MTP is up to date, you are 
ensuring that the CAS to MTP import will work as designed. 
 
 
SUPPORT INFO: Automatically check for MTP Updates 
 
There is a MTP System Setting that will automatically check 
for MTP updates upon login.  
 
To turn this setting ON, please go to System Settings > 
General > Updates and check the Software Updates box. 
 
If you’d like help with turning this MTP setting ON, please 
contact MTP Support. 

 
Image 5a 

 

 
Image 5b 

 

 
Image 5c 

 
 

 
 

https://www.membershiptrackingprogram.com/support
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6) Check or verify that you are logged in as your 
WORKDUES cashier in MTP 

 
Log in as your WORKDUES cashier. If you don’t have a 
WORDUES cashier, go back to the previous section, 
“Preparing for Your First CAS to MTP Import.” 
 
What are the steps? 
 
A) Go to File > Change User…  
and log in as your working dues cashier, WORKDUES. 
 
B) Click Yes when asked to open the WORKDUES register 
(Image 6a). 
 
C) Verify that you’re logged in as WORKDUES by checking 
username in the upper left-hand corner (Image 6b). 
 
Why are you doing this? 
 
As a best practice, we DO NOT USE your daily MTP cashier 
(where you take membership payments) when you perform 
the CAS to MTP Import process. If anything happens during 
the import process (errors, bad data, etc.) and you cannot 
close the WORKDUES cashier’s register, you will still be able 
to switch back to your daily MTP cashier and continue with 
regular membership payments like normal. 

 
Image 6a 

 

 
Image 6b 

 
 

7) Check and Address Existing Post Batch Payments 
Before the CAS to MTP Import 

 
Before a CAS to MTP import, please address any prior batch 
payments in MTP. The Post Batch Payments window needs 
to be empty (Image 7c). 
 
IMPORTANT!  If you have existing Post Batch Payments, 
address them before the CAS to MTP import. Contact MTP 
Support if you feel you need help. 
 
What are the steps? 
 
A1) Go to the MTP pop-down menu and select  
Utilities > Post Batch Payments… (Image 7a). 
 
A2) You can always use the Search menus box, in the upper 
right-hand corner of MTP, and type post batch. Then select, 
Utilities > Post Batch Payments (Image 7b). 
 
 

 
Image 7a 
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A3) If your register is not open, select Yes to open it. 
 
NOTE: The Post Batch Payments window needs to be empty 
to continue with the import (Image 7c). 
 
If the window has existing payments, please stop and 
contact MTP Support 

 
 

Image 7b 
 

 
Image 7c 

 
 

8) Open the Import Batch Payments window in MTP 
 
You are ready to import your Local-specific CSV file from 
CAS into MTP! 
 
What are the steps? 
 
A1) Go to the MTP pop-down menu and select  
Utilities > Import > Batch Payments… (Image 8a). 
 
A2) You can always use the Search menus box, in the upper 
right-hand corner of MTP, and type batch payments. Then 
select, Utilities > Import > Batch Payments…  
(Image 8b). 

 
Image 8a 

 

 
Image 8b 

 
 

https://www.membershiptrackingprogram.com/support
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9) Import your Local-specific CSV file from CAS into 
MTP 

 
What are the steps? 
 
A) Once the Import Batch Payments window opens, click 
the three-dot button (Image 9a). 
 
B) Find, highlight, and select your Local-specific CSV file 
inside the appropriate folder month under the [Year] 
[Month] folder structure that you created in Step 1. Then, 
click Open in the file window. 
 
C) Select Allow duplicate batches to be imported (Image 
9b) 

• Why? Because a member can have multiple work 
hours in one Local-specific CSV file from CAS. 

 
D) Select Import individuals not found as archived non-
members (Image 9b). 

• Why? The CAS to MTP import process will 
(automatically) add brand-new individuals to your 
MTP, when needed. 

• For Membership Type, select NON-MEMBER. 
• For Membership Status, select INACTIVE. 
• FYI - If District Council has an individual flagged as a 

Traveler, the local membership type will be 
overridden and set to TRAVELER with a local status 
of INACTIVE. Travel In Local number will be 
populated from District Council. 

 
E) Select Generate Membership Type Discrepancy Report 
(Image 9b) 

• Why? This report compares the DC Membership 
Type with your Local Membership Type. You need to 
resolve and correct membership type discrepancies 
before next month’s close business. 

 
F) Select Generate Inserted Individuals Report (Image 9b) 

• Why? This report shows you all the new individuals 
that were added to your MTP from CAS 
automatically – TRAVELERS and NON-MEMBERS. 

 
G) Select Generate Inserted or Update Contractor Report 
(Image 9b) 

• Why? This report shows you all the inserted 
(i.e. new) and updated contractors in your MTP. 

 
H) Click OK (Image 9b) 
 
I) Watch the progress bar (Image 9c). 

 
Image 9a 

 

 
Image 9b 

 

 
Image 9c 
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10) Save the Multiple Batch Import Inserted 
Individuals Report 

 
A Print Preview of the Multiple Batch Import Inserted 
Individuals Report will only be displayed (Image 10a) if 
there are new inserted individuals from the CAS import. 
 
If this report does not generate, proceed to Step 10. 
 
What are the steps? 
 
A) Save as PDF by clicking the Save icon (Image 10b). 
 
B) Save the PDF to the appropriate folder month under the 
Year > Month folder structure that you created in Step 1. 
 
C) Click the X in the upper right-hand corner to close the 
Print Preview for the import process to proceed. 
 
Why are you doing this? 
 
Saving the PDF is a good paperless practice. Having the PDF 
saved allows you to go back, review, and print as needed. 

 
Image 10a 

 

 
Image 10b 

 

 
 

11) Map or add new Contractors to your MTP 
 
All contractors found in the Local-specific CVS file comes 
from the CAS Portal (Image 11a).  
 
The Map Import Contractor Name window (Image 11b) will 
appear if an imported contractor cannot be reconciled 
automatically in your MTP with the following: 
 

• MTP check #1 – Contractor Number. 
• MTP check #2 – Contractor Name. 

 
All contractors listed in the Map Import Contractor Names 
window need to be mapped or inserted/added as new 
(Image 11b). 
 
What are the steps? 
 
A1) Check if the contractor already exists in your MTP, use 
the drop-down arrow  to map the contractor in to the 
correct profile (Image 11b). 
 

 
Image 11a 
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A2) When the contractor is new, click the three-dot menu 
button  to insert/add the new contractor to your MTP 
and then click OK in the window (Image 11c). 
 
Once all contractors have been mapped or inserted/added… 
 
B) Click OK (Image 11b) 
 
C) Watch the progress bar (Image 11d). 
 
Note 1: Contractors not mapped or added will not be saved. 
 
Note 2: If this is your first time performing a CAS to MTP 
Import, the process of mapping contractors can be very 
tedious. Rest assured, this process will speed up and take 
less time with each monthly CAS to MTP Import. 

 
Image 11b 

 

 
Image 11c 

 

 
Image 11d 

 
 

12) Save “Multiple Batch Import Inserted or Updated 
Contractors Report” 

 
Once the progress bar (Image 11b) is completed, a Print 
Preview of the Multiple Batch Import Inserted or Updated 
Contractors Report is automatically displayed full screen 
(Image 12a). 
 
This report shows you the inserted/added and updated 
contractors in MTP from the CAS import. 
 
What are the steps? 
 
A) Save as PDF by clicking the Save icon (Image 12b). 
 

 
Image 12a 

 

 
Image 12b 
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B) Save the PDF to the appropriate folder month under the 
Year > Month folder structure that you created in Step 1. 
 
C) Click the X in the upper right-hand corner to close the 
Print Preview for the import process to proceed. 
 
Why are you doing this? 
 
Saving the PDF is a good paperless practice. Having the PDF 
saved allows you to go back, review, and print as needed. 

 

 
 

13) Save “Multiple Batch Import Exception Report” 
 
A Print Preview of the Multiple Batch Import Exception 
Report is automatically displayed full screen (Image 13a). 
 
If this report does not generate, proceed to Step 14. 
 
What are the steps? 
 
A) Save as PDF by clicking the Save icon (Image 3b). 
 
B) Save the PDF to the appropriate folder month under the 
Year > Month folder structure that you created in Step 1. 
 
C) Click the X in the upper right-hand corner to close the 
Print Preview and read the important information below. 
 
If there are contractor(s) listed under the section 
Contractors in the file found in MTP more than once,  
do not proceed to Step 14 (Image 13a). 
 
Ex. Duplicate Name Contractors Search in MTP:  
PAN AMERICAN CONSTRUCTION INC (Image 13a). 
 
YOU MUST ADDRESS the duplicate name contractor(s) 
found in this report before you proceed or you will produce 
batch failure record(s) during the import process. 
 
If you have duplicate name contractors, STOP the CAS to 
MTP import process by clicking Cancel in Step 14  
and do not proceed until you address the contractors found 
in this report! 
 
What are the steps (fix duplicate name contractors) 
 
A) Under Contractors, use Smart Search and search on the 
contractor’s name that was listed – i.e. the name was found 
more than once in MTP. 
 

 
Image 13a 

 

 
Image 13b 

 

 
Image 13c 
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B) In the Search For Contractor window, review and verify 
the Contractor Numbers for each contractor listed (Image 
13c). 
 
C) Double-click on the contractor that you want to keep, the 
one that has the correct six-digit contractor number.  
 
D) Go Tools > Contractor Merge Tool (See Step 6) and 
merge the other contractor with the correct one. 
 
Once all the duplicate name contractors in this step have 
been merged/renamed/addressed, go back to Step 6 and 
start the CAS to MTP Import process over again. 
 

 
14) Enter numerical code to proceed with the CAS to 

MTP batch import 
 
What are the steps? 
 
A) Enter the numerical code in the white input box and 
click OK (Image 14a). 
 
B) Click Yes, to proceed (Image 14b). 
 
Why are you doing this? 
 
Because we trust the accuracy of the data being provided by 
the District Council’s CAS Portal, therefore it is OK to 
proceed.  

 
Image 14a 

 

 
Image 14b 

 
 

15) Save “Multiple Batch Import Membership Type 
Discrepancy Report” 

 
A Print Preview of the Multiple Batch Import Membership 
Type Discrepancy Report is automatically displayed full 
screen (Image 15a and 15b). 
 
This report shows you any discrepancies between an 
assigned standard District Council Membership Type (DC 

 
Image 15a 
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Type) and your Local Membership Type (Local Type) on 
individuals (members or TRAVELERS) that were listed in 
your local-specific CSV file from CAS that you imported into 
MTP. 
 
What are the steps? 
 
A) Save as PDF by clicking the Save icon (Image 15c). 
 
B) Save the PDF to the appropriate folder month under the 
Year > Month folder structure that you created in Step 1. 
 
C) Click the X in the upper right-hand corner to close the 
Print Preview for the import process to proceed. 
 
Example 1 (Image 15a): In the report, the Local has a 
member assigned with a Local Type of APPRENTICE but 
District Council has this same member assigned with a DC 
Type of TERMINATED. Who is correct – the Local or DC? 
 
Example 2 (Image 15b): In the second report, District 
Council has a member assigned with a DC Type of CONSTR 
LABORER but the Local’s Membership Type is 
JOURNEYWORKER. Who is correct – the Local or DC?  

 

 
Image 15b 

 

 
Image 15c 

 
 
Note: If there are any Membership Type discrepancies between 
District Council and the Local, save the PDF report, email it to 
District Council’s Kate Hughes at khughes@liunachicago.org as 
soon as possible, and resolve your Membership Type 
discrepencies by the next month’s close of business. 
 
Click here to review the standard membership types. 

 
 

16) Save Total Record Summary Window 
 
A window displays the Total Records, the number of 
imported successes, number of failures, and number of 
batches created (Image 16a). 
 
DO NOT CLICK OK, yet!  
 
Please use the Windows Snipping Tool to save a screenshot 
of this Total Records window. 
 
What are the steps? 
 
A) To open the Snipping Tool, press the Start key, type 
snipping tool, and then press Enter.  
 
Snipping Tool keyboard shortcut: 
Press Windows logo key + Shift + S  
 
B) Click File > New Snip and then box select the MTP Total 
Records window to capture the image (Image 16b). 
 

 
Image 16a 

 

 
Image 16b 

 

https://1drv.ms/x/s!AgKEndBYzK7NwkifdXBfZprShu4y?e=wpubRJ
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C) To save the snip/image, click File > Save As and save the 
image to the appropriate folder month under the Year > 
Month folder structure that you created in Step 1. 
 
D) Name the PNG or JPAGE file a Year-Month-Date 
Description file naming structure using the CAS Portal 
Publish Date. 
 
Example file name using the CAS Portal Publish Date:  
YYYY-MM-DD Batch Total Records.png 
 
E) Once you save the image, click OK. 
 
Why are you doing this? 
 
Document the batch failure records which you will help fix 
them when you contact MTP Support.  

SUPPORT INFO – If you have any batch failure record(s) (Image 
50), they must be addressed with your current month’s CAS to 
MTP import.  
 
Batch failure record(s) are related to payments not being posted 
under a specific contractor because their name or their 
contractor number was not unique. 
 
To find out what contractors are associated to the batch failure 
record(s), please go back to Step 12 and review the contractors 
that are listed under the Multiple Batch Import Exception Report 
– Contractors in the file found in MTP more than once section.  
 
Please note, batch payments for these contractors might have to 
be imported manually.  
 
Once the contractor(s) are addressed in MTP – with unique 
contractor number(s) and unique name(s) – batch failure 
record(s) related to the contractor(s) will no longer occur during 
batch imports. 
 
With help fixing your batch failures, please contact MTP Support. 

 
 

17) Save “Multiple Batch Import Report” 
 
A Print Preview of the Multiple Batch Import Report is 
automatically displayed full screen (Image 17a). 
 
This report shows you a list all the batch work hours 
imported into MTP from CAS by contractor number and 
contractor name. 
 
What are the steps? 
 
A) Save as PDF by clicking the Save icon (Image 17b). 
 
B) Save the PDF to the appropriate folder month under the 
Year > Month folder structure that you created in Step 1. 
 
C) Click the X in the upper right-hand corner to close the 
Print Preview for the import process to proceed. 
 
Why are you doing this? 
 
Saving the PDF is a good paperless practice. Having the PDF 
saved allows you to go back, review, and print as needed. 

 
Image 17a 

 

 
Image 17b 
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18)  Post Batch Payments 
 
Now that you’ve imported your batch work hours, the next 
step to post your batch work hours in MTP. 
 
What are the steps? 
 
A1) Go to the MTP pop-down menu and select  
Utilities > Post Batch Payments… (Image 18a). 
 
A2) You can always use the Search menus box, in the upper 
right-hand corner of MTP, and type post batch. Then select, 
Utilities > Post Batch Payments (Image 18b). 
 
 

 
Image 18a 

 

 
Image 18b 

 
 

19) Post Batch Payments 
 
What are the steps?  
 
A) In the Post Batch Payments window, please maximize 
the window (Image 19a). 
 
B) Scroll down and verify that you DO NOT have any Partial 
Posted payments. If you do, STOP and call INCOM Support. 
 
REQUIRED – Select the check boxes below: 
 
C) In the Post column, select the top check box, which will 
automatically select all the batch payment below 
(Image 19a). 
 
D) In the bottom left-hand corner, select all three reports 
options. These reports will be explained in the upcoming 
steps (Image 19a). 
 
E) Report format options: Select the first four check boxes 
to ensure data integrity (Image 19a).  

 
Image 19a 

 

C 

D 
E 

https://www.membershiptrackingprogram.com/support
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OPTIONAL – Contractor data import options based on your 
current CAS to MTP file: 
 
F) Template of Employees Options:  
 
Option 1: Check the Save employees to the template of the 
batch contractor: 
A) Optional: Check Overwrite current template to overwrite 
each Contractor’s Template of Employees tab  
B) Optional: Check Update each member’s contractor to 
update each member’s Contractor field on the Membership 
Screen (Image 19b). 
 
Option 2: When using MTP Dispatching functionality: 
uncheck the Save employees to the template of the batch 
contractor box so that last month’s Close of Business CAS 
data does not overwrite any Contractor’s Template of 
Employees tab or a member’s Contractor field on the 
Membership Screen (Image 19b). 
 
G) Click, OK (Image 19a). 
 

 
Image 19b 

 

 
 

20) Save “Post Batch Payments Proof Report” 
 
A Print Preview of the Post Batch Payments Proof Report is 
automatically displayed full screen (Image 20a). 
 
This report lists the total dollar amount of WORKING DUES 
that was imported into MTP from CAS.  
 
 
Note: The actual amount that gets distributed to your Local 
will be the WORKING DUES total (above) MINUS your 
required Local CONTRIBUTIONS to the other entities – i.e. 
GROC, etc. 
 
What are the steps? 
 
A) Save as PDF by clicking the Save icon (Image 20b). 
 
B) Save the PDF to the appropriate folder month under the 
Year > Month folder structure that you created in Step 1. 
 
C) Click the X in the upper right-hand corner to close the 
Print Preview for the import process to proceed. 

 
Image 20a 

 

 
Image 20b 

 
 

 
 

F 
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21) Save “Individuals Without Initiation Dates”  
 
A Print Preview of the Individuals Without Initiation Dates 
report is automatically displayed full screen (Image 21a) if 
you have members receiving Working Dues that do not 
have a date filled in the Local Initiation Date field on the 
Dates tab (Image 21c). 
 
If this report does not generate, proceed to Step 22. 
 
 
These members are typically either Transfer Ins or 
TRAVELERS – manually added or through the CAS to MTP 
Import process. In either situation, the Local Initiation Date 
may not have been set. 
 
What are the steps? 
 
A) Save as PDF by clicking the Save icon (Image 21b). 
 
B) Save the PDF to the appropriate folder month under the 
Year > Month folder structure that you created in Step 1. 
 
C) Click the X in the upper right-hand corner to close the 
Print Preview for the import process to proceed. 
 
D) Click No in the Set Initiation Dates window (Image 21d).  
 
Before next month… 
 
Address each member’s Local Initiation Date for the Per 
Capita Report. If you don’t, the report will be generated 
each time you perform a CAS to MTP import.  
 
Therefore, for each member listed, manually set the flag as 
Hide for Local Initiation Date in the Dates tab (Image 21c) 
 
Then set the Local Initiation Date – to the same date as the 
International Insert Date (Image 21c). 

 
Image 21a 

 

 
Image 21b 

 

 
Image 21c 

 
Note: If there are any members without initiation dates, save the 
PDF report and address each member as soon as possible or at 
least by the next month’s close of business date. 
 

 
Image 21d 
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22) Select Batch Payment Post Options 
 
In the Batch Payment Post Options window, please use the 
following options (Image 22a) 
 
What are the steps? 
 
A) Payment Date: Use Publish Date noted in Step 3G page 
14 – i.e. the date the Zip files were publish to the CAS Portal 
. 
• Why? Use the CAS Portal Publish Date so that it will be 

displayed as the Receipt Date, under the Contractor 
Hours tab in MTP. 

 
B) Payment Method: In the pop-down menu, select D. DEP. 
• Why? Auditors know that Locals don’t receive physical 

checks for work dues, therefore they want to see 
direct deposit flagged. 

 
C) Comments: Type the month and year for the imported 
data from CAS – i.e. the prior month’s close of business. 
Example: JAN 2021 CAS DATA 
• Why? Track and document which month’s close of 

business data was imported. 
 
D) Post Options: Select Contractor register. 
• Why? Both Member and Contractor register options 

produce the same summary report but the Contractor 
option is easy to read and more concise. 

 
E) Check Show amounts as zero in register. 
• Why? The working dues is not directly processed in 

MTP therefore it comes in as a batch history record 
from CAS. 

 
F) Print Receipt Options: leave all options unchecked. 
• Why? You’re not printing any receipts. 

 
G) Email Receipt Options: leave all options unchecked. 
• Why? You’re not emailing any receipts. 

 
 
H) Deletion Options: Select Subtract amount from register. 
• Why? The option corrects data errors if there are 

negative amounts in the batch import. 
 
I) Check Remember above settings. This check only applies 
to the three “Options” settings above. 
 
J) Click OK. 
 

  
Image 22a 

 

 
Image 22b 

SUPPORT INFO: A common error can occur with Batch Imports 
from CAS when a negative amount has to be subtracted from a 
member (who has no reported working dues) typically because of 
an audit adjustment. 
 
To fix these types of batch issues, please contact MTP Support. 
 

A 

B 

C 

D 

E 

F 

G 

H 

I 
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K) Watch the progress bar (Image 22b). 

 
Image 22c 

 
Note: You can view your Batch Payment comment under the 
Payment History and Invoice History tabs once you’ve 
completed the CAS to MTP Import process (Image 22c) 

 
 

23) Save “Inactive and Archived Members in Batches 
Report” (1 of 3) 

 
A Print Preview of the Inactive and Archived Members in 
Batches Report is automatically displayed full screen  
(Image 23a). 
 
What are the steps? 
 
A) Save as PDF by clicking the Save icon (Image 23b). 
 
B) Save the PDF to the appropriate folder month under the 
Year > Month folder structure that you created in Step 1. 
 
C) Click the X in the upper right-hand corner to close the 
Print Preview for the import process to proceed. 
 
Why are you doing this? 
 
Saving the PDF is a good paperless practice. Having the PDF 
saved allows you to go back, review, and print as needed. 

 
Image 23a 

 

 
Image 23b 

 
 

 
 

24) Save “Hours for Non Members and Inactive 
Members in Batches Report” (2 of 3) 

 
A Print Preview of the Hours for Non Members and Inactive 
Members in Batches Report is automatically displayed full 
screen (Image 24a). 
 
What are the steps? 
 
A) Save as PDF by clicking the Save icon (Image 24b). 
 
B) Save the PDF to the appropriate folder month under the 
Year > Month folder structure that you created in Step 1. 

 
Image 24a 
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C) Click the X in the upper right-hand corner to close the 
Print Preview for the import process to proceed. 
 
Why are you doing this? 
 
Saving the PDF is a good paperless practice. Having the PDF 
saved allows you to go back, review, and print as needed. 

 
Image 24b 

 
 

 
 

25) Save “Hours by Month Paid for Non Members 
and Inactive Members in Batches Report” (3 of 3) 

 
A Print Preview of the Hours by Month Paid for Non 
Members and Inactive Members in Batches Report is 
automatically displayed full screen (Image 25a) 
 
What are the steps? 
 
A) Save as PDF by clicking the Save icon (Image 25b). 
 
B) Save the PDF to the appropriate folder month under the 
Year > Month folder structure that you created in Step 1. 
 
C) Click the X in the upper right-hand corner to close the 
Print Preview for the import process to proceed. 
 
Why are you doing this? 
 
Saving the PDF is a good paperless practice. Having the PDF 
saved allows you to go back, review, and print as needed. 

 
Image 25a 

 

 
Image 25b 

 
 

 
 

26) Close Register 
 
Now that you’ve posted your batch payments, it’s time to 
close the WORKDUES register.  
 
What are the steps? 
 
A1) Go to the MTP pop-down menu and select  
Utilities > Close Register > This Register (Image 26a). 
 
A2) You can also use the Search menus box, in the upper 
right-hand corner of MTP, and type this. Then select,  
Utilities > Close Register > This Register (Image 26b). 
 
B) Click Yes to close your WORKING DUES register  
(Image 26c). 

 
Image 26a 

 

 
Image 26b 
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Image 26c 

 
 

27) Save “Register Summary Report” 
 
A Print Preview of the Register Summary Report is 
automatically displayed full screen (Image 27a). 
 
What are the steps? 
 
A) Save as PDF by clicking the Save icon (Image 27b). 
 
B) Save the PDF to the appropriate folder month under the 
Year > Month folder structure that you created in Step 1. 
 
C) Click the X in the upper right-hand corner to close the 
Print Preview for the import process to proceed. 
 
Why are you doing this? 
 
Saving the PDF is a good paperless practice. Having the PDF 
saved allows you to go back, review, and print as needed. 

 
Image 27a 

 

 
Image 27b 

 
 

28) Save “Cashier Audit Report – Member Register” 
 
A Print Preview of the Cashier Audit Report – Member 
Register is automatically displayed full screen (Image 28a). 
 
What are the steps? 
 
A) Save as PDF by clicking the Save icon (Image 28b). 
 
B) Save the PDF to the appropriate folder month under the 
Year > Month folder structure that you created in Step 1. 
 
C) Click the X in the upper right-hand corner to close the 
Print Preview for the import process to proceed. 
 
Why are you doing this? 
 
Saving the PDF is a good paperless practice. Having the PDF 
saved allows you to go back, review, and print as needed. 

 
Image 28a 

 

 
Image 28b 
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29) Save “Cashier Audit Report – Contractor Register” 
 
A Print Preview of the Cashier Audit Report – Contractor 
Register is automatically displayed full screen (Image 29a). 
 
What are the steps? 
 
A) Save as PDF by clicking the Save icon (Image 29b). 
 
B) Save the PDF to the appropriate folder month under the 
Year > Month folder structure that you created in Step 1. 
 
C) Click the X in the upper right-hand corner to close the 
Print Preview for the import process to proceed. 
 
D) Click No. (Image 29c). 

 
Image 29a 

 
Note: If any line items your report show an ERROR, please 
contact INCOM MTP Support. 

 

 
Image 29b 

 

 
Image 29c 

 
 

30) Select Print Fee Distribution Report Options 
 
In the Print Fee Distribution Reports window please use the 
following options. 
 
What are the steps? 
 
A) Check Fee Distribution Summary (Image 30a). 
 
B) Uncheck Fee Distribution Details by Payment Method 
(Image 30a). 
 
C) Uncheck Include payments to previous balance (Image 
30a). 
 
D) Check Include payments that post as zero in register  
(Image 30a). 
 

 
Image 30a 
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E) If this window pops up, click OK (Image 30b). 

 
Image 30b 

 
 

31) Save “Fee Distribution Summary Report” 
 
A Print Preview of the Fee Distribution Summary Report is 
automatically displayed full screen (Image 31a). 
 
What are the steps? 
 
A) Save as PDF by clicking the Save icon (Image 31b). 
 
B) Save the PDF to the appropriate folder month under the 
Year > Month folder structure that you created in Step 1. 
 
C) Click the X in the upper right-hand corner to close the 
Print Preview for the import process to proceed. 
 
YOU ARE ALMOST DONE… 
 
Proceed to the next section, CAS to MTP Post-import 
Validation (page 35) to verify all records and dues were 
imported correctly from CAS. 

 
Image 31a 

 

 
Image 31b 
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CAS to MTP Post-Import Validation Checks 
Check 1) 
Review the screenshot of the Total Record Summary 
Window (from Step 16, page 24).  
 
The Total Records imported, e.g. 1331 (see Image A) 
should be equal to the number of rows imported from 
your Local-specific CAS to MTP file, minus the Row 1 
header row (see Image B).  
 

 
Image A 

 

 
Image B 

 
Check 2)  
Review the screenshot of the Total Record Summary 
Window (from Step 16, page 24).  
 
The number of contractor Batches created during the 
import, e.g. 370 (see Image A) should be equal to the 
“Cashier Audit Report – Contractor Register”(from 
Step 29) Total Transactions, e.g. 370 (see Image D). 

 
Image C 

 

 
Image D 
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Check 3) 
The three reports, to the right, should all have the 
same total Working Dues amounts – the monies 
should be equal. 
 
Image E – Detail Contribution Group by Local: Total 
Dues column (PDF from Step 3E, page 14) 
 
Image F – Post Batch Payments Proof Report: Grand 
Total (PDF from Step 20, page 27) 
 
Image G – Fee Distribution Summary Report: Grand 
Total (PDF from Step 31, page 34) 
 
 

 
Image E 

 

 
Image F 

 

 
Image G 

 
  
Last Step! 
For the protection of your members against identity theft 
(stolen/shared files or a printed report), please delete your 
Local-specific CSV file from your computer. 
 
What are the steps? 
 
A) Go to the appropriate folder month under the Year > 
Month folder structure that you created in Step 1 and… 
 
B) DELETE your Local-specific CAS CSV file from your 
computer or shared-drive location (Image 32a). 
 
Why are you doing this? 
 
Three reasons: 1) The .CSV file contains SSNs and working 
due amounts on members of your Local, 2) You are 
removing the potential for your Local to be held 
accountable for identity theft on any member found in the 
file and finally, 3) You are ensuring that you don’t 
accidentally select it during next month’s CAS to MTP 
import.  
 
YOU ARE DONE! 

-  
Image 32a 

 
 

 
 

$123,456.78 

$123,456.78 

$123,456.78 
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Resolving Discrepancies between Local and DC Membership Types  

What are DC Membership Types? 
In addition to contractor and hours, DC also tracks 
their own Membership Types in CAS based on how the 
individual is viewed within the Westchester and Fox 
Valley Funds. Examples are: 

• Travelers (i.e. out of district) 
• Salaried Supervisors 
• Union Officers and Staff 
• Retired 
• Etc. 

 
All three entities, 1) DC, 2) the Training Center, and 3) 
the Locals have their own Membership Types in the 
effort to track individuals within their separate 
accounting/membership tracking systems. 
 
FYI – CAS is the accounting system used by the LIUNA 
Chicago Laborers’ District Council to track and manage 
contractors and member’s contractor hours. 
 

 
Image A 

Training Center Membership Screen 
Memberhsip Types (from top down): 1) DC, 2) Local, and 3) Training Center  

 

 
Image B 

Local Membership Screen 
Memberhsip Types (from top down): 1) DC, and 2) Local 

 

How do you know if you have a DC Membership Type 
Discrepancy? 
During the monthly import of your Local-specific CAS 
data file into MTP (which tracks and updates your 
local’s contractor hours, information, and work dues), 
it also updates the read-only DC Membership Type 
field on your MTP Membership Screen. 
 
During the CAS to MTP import, the option to print the 
Multiple Batch Import Membership Type Discrepancy 
Report is selected (Step 9E, page 19) and then saved 
with your other import reports (Step 15, page 23). 
 
 

 
Image C 
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What are the steps to fix/address your DC 
Membership Type Discrepancies? 

1) Review your Multiple Batch Import 
Membership Type Discrepancy Report 

2) Print and highlight the individuals that you feel 
need to be fixed/addressed 

3) Scan and save the report as a PDF 
4) Attach and email the highlighted PDF report to 

District Council – Kate Hughes, 
khughes@liunachicago.org.  

5) District Council will review your highlighted 
discrepancy report and check for (or request) 
proper documentation under the Documents 
tab in MTP before any changes will be made. 

6) IMPORTANT: Resolve any DC Membership 
Type discrepancies as soon as possible or at 
least by the next month’s close of business. 

 
Image D 
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Best Practice 
 

Right-click and add frequently-used reports to Report > Favorites 

Add a report to your Favorites 
 
What are the steps? 
 
A) Go to the MTP pop-down menu and select Reports > 
Membership Reports > Local Members Assignment at 
Training Center Report (Image 1a). 
 
B) Once you find the report, right-click on the highlighted 
report name. 
 
C) Click Yes (Image 1b) 
 
Your report is now added to Report > Favorites (Image 1c). 
 
And don’t forget… 
 
You can always use the Search menus box, in the upper right-
hand corner of MTP, and type local assignment. Then select, 
Reports > Membership Reports > Local Members Assignment 
at Training Center Report (Image 1d). 

 
Image 1a 

 

 
Image 1b 

 

 
Image 1c 

 

 
Image 1d 
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Check that you are receiving working dues on your ACTIVE, NEW, and PARTIAL status members 

Check that you are receiving working due on your 
ACTIVE, NEW, and PARTIAL status members 
 
FYI: A member must have the same local assignment at the 
Training Center as they do at your Local – i.e. one-to-one with 
local assignment – for working dues on that member to be 
allocated to your Local. 
 
REMINDER: Local Assignment determines three things: 

1) MTP bi-directional synchronization 
2) Working dues distribution to each Local 
3) MCL benefits 

 
There are two ways to check and verify the local assignment 
of a member at the Training Center. See below. 
 

1) Check a single member from the Membership Screen 
a. Search for the member 
b. Select the QR Code on the row of icons and select 

Open in browser (Image 1a) 
c. You can view the member’s Public Directory  

(Image 1b), that member is one-to-one with Local 
Assignment 

 
2) Check all members in your MTP 

a. Go to the MTP pop-down menu and select  
Reports > Membership Reports > Local Member 
Assignment at Training Center Report (Image 1c) or in 
the Search menus box, in the upper right-hand corner 
of MTP, type local assignment and select Local 
Member Assignment at Training Center Report 

b. Under the Report section, check Unassigned Members 
(Image 1c) 

c. Under the Membership Type to include: section, 
select Check All (Image 1c) 

d. Under the Statuses to include: section (Image 1c), 
check: ACTIVE, NEW, and PARTIAL PAYMENTS 

e. Select Mask first 5 digits of SSN 
f. Click OK (Image 1c) 
g. Save the PDF to the appropriate folder month under 

the Year > Month folder structure that you created for 
your CAS to MTP imports. 

 
Image 1a 

 

 
Image 1b 

 

 
Image 1c 

 
Note: If there are Local Assignment discrepancies, save the PDF 
report, and email it to District Council’s Kate Hughes at 
khughes@liunachicago.org as soon as possible and resolve your 
local assignment discrepencies as soon as possible or at least by 
the next month’s close of business date. 
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